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ABSTRACT

Drought severely affects the Thai people every year. The application of drought

indicators can reduce severe impacts. However,

the accuracy assessment of the

drought index is the first step to be studied before turn it into practical task. Therefore,

the objective of this research is to study the accuracy of drought indices in the lower

northern region of Thailand by using satellite rain estimates product, tropical rainfall

measurement or TRMM 3B42 Version7. By subjectively selecting four commonly used

drought indices which are average, Decile range, Standardize Precipitation Index (SPI)

and Generalized Monsoon Index (GMI). TRMM product was extracted corresponding to

rain gauge position of Thai Meteorological Department (TMD). Then, Inverse Distance

Weighted (IDW) interpolation method was applied to obtain spatial data of those

indices. The results show that SPI'is-more accurate than other indices when compare

with drought report from department of disaster prevention and mitigation.
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USinamusnteeniunvsedulinndesnuggnia daslunisiafe anmendvsuanuliis
Tuagr 1 adwnsvialifdunndadaduiiu 15 Julugiggeu Aundsaruisonusladu 4
UseLAn A9

1) - iugnlesdnepluwamiangis annisniidutosvselidiuaslutianamis 8

a Py =1 Y PR ) ' | P
AuUnRIfesiing IngTuadiuaniuiiuazgania o M 9 aae

2) FUNNTINEATHULAS NUIBDI @NIENITVINLAAUUIVDINY

1%
[y o

3) PUENNINEWULEY NIt aneissauiniAukagldfuanamzounluwii
amAaBIanad
4) PMULATEFAAATHULAY MN8A9 A01IEN1TVINLARLLET FINANTENUADANIN

\msugialugilnna (nsugeleuinel, 2560)
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2.3 A28 Tropical Rainfall Measuring Mission (TRMM)

muﬁwq@ﬁaﬁmmﬁ%adﬁ The Tropical Rainfall Measuring Mission (TRMM) U1
1ATIN19A2IU52U 8AUTZ1A119 National Aeronautics Space Administration (NASA) Lay
Japan Aerospace Exploration Agency (JAXA) Suldaudletud 27 NOAINYU WA, 2540

(Islam, M.N. and H. Uyeda, 2007 919991 (ASUnNSANE wnws1il, 2557)

TRMM 1Juanafisudsiiadaaslidduiusiuniserfing (Non-sun-synchronous Orbit)
NszAuaNLEs 403 Alawns seuUlAastdes (Inclined Orbit) vy 35° Aulduaudans fs
A 2.2 16a1 92.5 w1l dmsunisiaasseulan 1 sou laasvisuun 16 seulunileiu

(National Aeronautics and Space Administration, 2012)
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A8 TRMM o’?mﬁqqﬂﬂsaﬁﬁuwu Passive Microwave Laghuu Active Microwave

[

faam 2.3 Wlunsfinymglusazaniwnfonidluinou adlgunsaifiddyues TRMM
fog5 vllnfe

1) #3904 PR (Precipitation Radar) ¥a1ufiviendu 13.81 GHz finuaziden 4.3
Alaluns

2) 1383 VIRS (Visible/Infrared Scanner) ¥inguiitasndu 0.60-12 lalasiuns Ay
azlen 2.0 Alawns

4) \A389 TMI (TRMM Microwave Imager) i 5 Band width ¥1391ufi%33 10-90 GHz
ANAZLEEN 5-45 Alalng

5) 1A399 CERLS (Clouds and the Earths Radiant Energy System) v191ufigaa 0.3-
50 lulAsiuns AuazLdgnUsyann 25 Alales

6) 4A309 LIS (Lightning Imaging Sensor) ¥a1ufi 433 0.774 lulasiumsanuasden
4 Alakms

v A

dmivgunsalnsivianundAyngaues TRMM A 1389 PR 1H8931nTA1A1Y

o

P a ) dl 44' = o w a
azLEJEJﬂLLasﬂ’ﬂiJﬂ‘ZJENMiG]‘J’Jﬁ]’mq\‘itm I99a9U1IABLATRY TMI LLlagtaTed VIRS Auanu (A

UNSANG WIUSIH, 2557)
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Height 403km
16 times per day
9 every 92.5 min

AN 2.2 A1iied TRMM
17im: National Aeronautics and Space Administration

TRMM Mcowee Irager

VIRS

Visltde efrarnd SGover

Precipitation Radar

Clouds and Earth's Radlan Energy Symem

2w 2.3 dneaiznlmasuazgunsaldrsiavesnnaiiey TRMM

<

u1: National Aeronautics and Space Administration 19991 F3UNSHANE

wnusal, 2557
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2.5 a1iigy TRMM wasnanineiiiny TRMM 3B42 V.7
nUsrasAvesdanaifiy TRMM 3B42 Aon1swannansiust TRMM AUSuLALE 1678
N33 mBuNTIIA (IR) vosmeInilazAlaaen1a3ded (Root-Mean-Square:RMS) U84n13

USLUIUAINIIAUIHNNRANAR 9ANDSNUUTENDUMUADITUADULASNNINITHNAIULAS NS

a

aoulioy deanineudngldnseniniidenuasdeaduseuuasdanuasidoneiiy
0.25°x0.25° A UARY Faua-50°tnile 8950014 (National Aeronautics and Space
Administration, 2013) @ea1aifies TRMM ainsfauisanesfivesaaiiomansesdu
TnenanSasiinay TRMM 3842 V.7 Uszneudiewueesild 1dun Advanced Microwave
Scanning Radiometer, Advanced Microwave Sounding Unit- A, Advanced Microwave
Sounding Unit-B, TRMM Precipitation Radar, Special Sensor Microwave Imager/Sounder,
TRMM Microwave Imager, Visible ke Infrared Spin Scan Radiometer(GMS Series), Visible
e Infrared Spin Scan Radiometer (METEOSAT Series) Fawandamidnuiliinuaziden
el 0.25° x 0.25° ArmaziBeamsisie Hufntrsanlunisiufindeyaidusietu
maUﬂqmmL’sméfuwﬁfuﬁ 31 §uneu w.A. 2540 fadagtunnsndlnes Ae dnsin1sinnrein

1911 (National Aeronautics and Space Administration,2015)

2.6 NMIUTTIIUTIYARNTSNUN

2.6.1 YeULASZAIUANNY

nsuszanaA U iunalsendus 11nsUsTana gl Wunsvihuneuwn

1
1 | al

LU ANTIAUNINVD IR UMY TENINATTIToYa T LaglEIT N s adinenansuavat
wuusineg Tunsviunegaianan dansuuuuldvdnnisadieiufe aieglndsiumisaula
wdnENaNINNINYRTegriteanty Fann 2.4 eI a1 TaNIIUANTIAUNINYDS

q 9

A Ay v o I | =~ Y o o v L PP a 2 ' v
Wunlannga MalenaliawnINToIINAGIUVANUN YAAINT 1387 1AS0 910 wazA1lddny
Ugda Yaa] =Y 1 v n'ded'd' Q’Jldo ld'% Y
satudadenlddsnisinuilegslvnsyareminunnaula anduleviuigaidululealviu
o ] A dy d'd' v Y & 1 v a ¥ 1
swvtansenunnlilaiuAmtayassemensussiae

Tugr9n1sUsenaianluge wuadu 23888 1) nrsussuaalugisuuudetilos
(Continuous Interpolation) 1HuAsATInsIUAB ULUased19AnelursglUronsUsE U AN
AEATNITNIIANAFIEASHATEDNA LU NITAIUIUAITEEENI9NaUIABUINEA (Inverse
Distance Weight) t{udu 2) nsuseanaalutisiuuliseiiios (Discrete interpolation) tdu

FBNLNTUALULUAI9E19BUNAUTDINTITUS LU UAN AT LA ULU U ILARLANTALAU LTU I5NNT
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4

as1egunanemdeuiiaiau (Thiessen Polygon) 1Jusiu (AfeUjUnnisseuvansaumna

pilansdmsuimnsmilos, 2561)

2.6.2 "‘J%ﬂ'ﬁﬂizmmﬁﬂ%’aga@aﬁuﬁ
1) Inverse Distance Weight (IDW) svgzmandulnevnin msfunAsyes
nandulagihain (DW) 1uisnrsuseanmalutisuudeides Tnsviinisduimaign
FrogaunazsunisfidswanssnusediuiiseUsnaiidesnisuszanaanld Famanseny

duiusiussezs fe aaeglndnudumisinesnsAuinmaasiuniniinningaied

Y

lnasenl FBMstiminzAunsadlnAweswls A watuin sUTuAInUsE 9N

Mg (AReURUnMIsEULasAUIAgIAEnSdmMIUIAINIIMETRNS, 2561)

12
10 4‘1;,- ] .
12 T
20 10
- [ ]
6 [ ]
Value|
-
® - o
®
L 4
> Distance )
-
Value
Distance >

AN 2.4 N15UTTUIUANTINUN

fian: Geography and Environmental Science
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2.7 MSAUIUABUAY

Fui¥nfoudafiunnunevanesie wilufidarnandsseiildmundoudsdunsane
iy lunisaneildidenldisnsAuiasoudsfideuldfuialy 4 dud laun doi
Average, 7 %1l Decile Range ¥l Standardize Precipitation Index (SPI) wag @ %

Generalized Monsoon Index (GMI)

2.7.1 AvUAverage
Ialeisladunamiaaans niaaasUTuaudily dsmlaainnisiiAusnanu
nadindinululeingg usuiuidmsieiuintdeda laglun1sfin widladaudas

FFnsaanaradu faaunis 2.1 wag auns 2.2 (Chow, v.t. ed, 1964)

n J
R, = Xic1 Rik
n
a 3 oA = | = =
aUSinanhruseUnseseggnia e Tuyie n U (n=30 U)

X
=1
o))}

v

] N a a
i A9 ULSUAUNNATUN

=1

R AavUsunanieusetunsesiegania vasUiik
U

R« AoUSunautdusehou Tunoud | vesln k
. a a a v da
i A9 LAeUSUAUNNITN

) Ae Whsugavnginansan

AUN15 2.2 MsAuinAaaeUsitauiny 30 U

danuuanial R, waz R leuaidahudssudieua dslunisanwiilamuunnasinig

fAsanld fepsne 2.1
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A19719 2.1 NUIINSNAITUIAILALRAY

nAsSeurigu NANISIATIZN
Re < R, TGN
Re > R Tlaiuas

2.7.2 A%# Decile Range %39 Rainfall Decile

ImaLLﬂa%’a;ﬂaﬂ%mmﬁmuaamﬂu 10 929919 U ¥M8E 10% VDINATINUBINITHAN
wasilafunisuanuaswuuuni G‘fﬂﬁ?ufiaumiﬁflmmﬁaﬁamfﬁa;gaﬂ‘%mmfmummammﬁ2
vosmnineu ielriinrulndifssiunisuaniauudnd aanduiuihdeyamduanm

ALRAY kazANMUL UL UNNINGEIU AIENNTT 2.3 (w.j Gibles Wag J.V Maher, 1967)

Ajjn— Hijn
INGNT Zij n— ———
’ Oij,n
[y Y < J—
Jnguaunsladu Zij,n = Uijn T O'ij,nZij,n

lnoil X fio USinanidusielvsesioggnia ludaa n ¥
Uijn fo fAedediinanWuselviosieggnia livie n U

2 | a a 5 A | =
Ojjn A9 UL UUINATEIWTRIUSINUIHIT e TN 899N 8 lugen ¥
Zijn 8 Quantile ¥99 Normal Distribution esUSinaninusielvsesieggnia
Tugan ¥
. a a a v da
i P9 LARUSNANTINANTIN
. a a Y aa
j Ao Wwauany e

o IS
9 UIUlTeYA

o))

n

aun13 2.3 M3Au Decile Range
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NA15 AR UTLEEUIAIUNR WUl 10% Decile 9zns1afuAn Z = -1.2817 Fauis
anunsofwmma X, | ld wagldidlon X, be9zfAosunindased wionduluegluinmusi
UnamuseUudoneggnianuund nsun Decile duq vihlsidu nsmd1 10% (Decile)
9INN13AILIAILA Decile 71 1 4 Decile 71 10 agldfidovesUmamuseTvioneggnia
uiae Decile ¥ilannsafinrsanléd TuwiasT USinmrumeTvioneggnavesiiuiidus
aneglutas Decile Range fisils idnwazduidusgasls Tnsinausilunsfiansan fness
2.2

fngiil Decile Range furndiiivsusnannerduluiuiilafuiindsiunnsiean
Aadsuinnitesniniiedls Iag Decile Range 71 1 wneds Usunasluiidsininaads
1119 (very much below average) Juonthuluidsdn uag Decile Range 71 10 wined

USunaurlunfienganinAiadenine (very much above average) 3o UTUUA

A1579 2.2 INAINTSNA15IR8Avil Decile Range

Decile Range  %74A1 Decile pA AN Anwog
1 <10% <-1.28 fNIIRNRAENINY AR
2 10%-20% -1.28 §9-0.84 fndAnadeunn AN
3 20%-30% - -0.84 §3-0.52 fninAade HUADUTIINA
4-7 30%-70%  -0.52 913 0.52 Aade lutunang
8 70%-80% 05214 0.84 genineiedy AERMTENG
9 80%-90% 08471128  geniiduadoun Hlf

10 >90% >1.28 genidedeuing FluFNN
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2.7.3 A%l Standardize Precipitation Index (SPI)
JusrifiimutuiietmunuazninaniisuiuddasuTinulu lneasiiouds
Anuuudann L dudadefidmaliinanuuidsluusdasrsaialuan
Unf (Aiede) WWudrnutuiu Yiinanilusafiui wasthitlualuwivh Tnglddeyausina
iy annfiwagdsnamil 9 udlEIBnswasAeynIunatvesu Tieglusunisuan
LUNALUULNATT UL DAY SPI dmSvaniuiinazdraaniu q sdriidululunisau
wanafanuuands anuarsrdfidulilunsuiniansieanuduiunioitumnniiung &

dunng 2.4 (ARESS LNEULAA ,2561)

>(ij' Xim
Spl=—"
‘ . o
X ﬂawaﬂ"ﬁ’mﬂ%mmu’lr}lumaaiﬂEJL@EJ‘LJ‘VIamu [y L@EJUJ (ﬁaalﬁi@ﬁ)

X AsUSuauiniad g s e eutaUN AN eI UNAN®Iv09d0 1w (aakuns)

O  Fed s uuNINTgIU

FUN13 2.4 MIAUIUUIHUINDAATIZATZAUANINTULTIVIAB LAY

WIoAMINIAY SPI 11lekad 39NN NINENEVBIANULALAY IReRNTAN

NI 2.3

A1519 2.3 INAEINISNANTAUNAAYT Standardize Precipitation Index (SPI)

SPI sEAuTtlduUs
> 1.50 HufInn
1.00 09 1.49 pluf
0.50 99 0.99 HuADUT1A
-0.49 §3°0.49 HuUNG
-0.99 91§ -0.50 ADUT LA
-1.49 84 -1.00 WA

<-1.50 LAIIM
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2.7.4 sviiGeneralized Monsoon Index (GMI)
Generalized Monsoon Index (GMI) 1JuadmlA ULt ud s NI eAsLEA
DanansEnuUliaLAfisniawasyRule Sullanveilownann1suIaLAauAINTY Fati

N153ATIENAT GMI Favilvianansansivanelaeniluvesivldimunugnlugausau lag

1
= [

GMI %ﬁﬂ'wuaqﬂuﬂ%mmmuimLﬁausluizwjmmq@mqmﬁ?u 7 ilosaninlutisszinm
nanaiieunqunAufsnaafeunaauietdutisivszmalneegneliavinavesauusan
nzfunnidedd wagilutsgqunzdgnuesiialeaeiialy azdurn GMI Aldluiisadue ami
Tunausauny fusnidedilasfisrsananUsamussuideuigusuiafoususieu f GM

fanananusamniulaannaunis 2.5 (Achutuni, 1982)

GMI = 0.125 P6 + 0.125 P7 + 0.5 P8 + 0.25 P9

4

wRaulnuIeu GMI6 = 0.125 P6

q

2\

(%

duounsngAy GMI7 = 0.125 P7

AUFaUAmnAY GMIS = 0.5 P8

AuLAaunuengu GMI9 = 0.25 P9

dun15 2.5 MUy nduhaui.e - n.e.

A1 GMI fisunalldagiimineduliafuns ogalsfauen oM i anunsovhlieglugy
Juld 19U WeslwusiuasAn GMI Und wWesleudlndvesdrfuiives GMI 1a= waziileanny
azmanlunisimuainueiuinsg udildlunisiiansananiazaesiin oM avegluguves
percentile rank FagiAn5z91313 0 - 100 331391 percentile rank v83 GMI Jumldlnenis
UIADUNTULIAIYBY GMI BB IUATEUTIIMNT B UIINURLUNININ LA AIUIUAT

percentile rank w84 GMI laa1n @uns 2.6
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GMlpct = (r x 100)/ (n + 1)
GMIpct : percentile rank U84 GMI
r: é”]é’uﬁmmﬁﬁfayjaau GMI v09Uu 9

n: Mulveslayaveusavanil

r<n ez GMlpct <100

#UA15 2.6 AU Percentile Rank (GMl)

N0 GMI e TLENINTANANIUDINY AINITI9 2.4

A15719 2.4 LNUSIN15AA15UI928AUT Generalized Monsoon Index (GMI)

LNEUI GMI,; AN12LVDINY
0-20 183397 (severe drought impact and possible crop failure)
21-30 WA (drought impact on crops)
31-40 ABUTIMAY (moderate drought impact on crops)
41 - 60 Un# (normal crops)
61-90 mm%uqaﬂ’iﬂﬂﬂ@ (possible above normal crops)

91 - 100 AMUTULAUAIUABINTT (possible excessive moisture)
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av ad v

2.8 LanN&13LbasIuUYNINYIVIY

a o [ v

3515 oA UAINA (2551) AnwineInusvdSsLadNonIasiInfoLadniianinu

< &

gnspssausulalunsufifuarannsadilulylaess lngldquineudunundnwm Tunisfinw

' [
YU Ao =

Hlaun 78 Average, 78 Decile Range ;38 SPI 3% GIM wazlaldaafdnAnwrvunlnil Aeds

Average Seasonal Change Index @uuUsaldlunisAruiuduiisudednge Ao YSuiaidu

eUuazs1enansene lugel w.e.2518-2548 53 31 Uvesaniilin 45 uvsiinsegduuiey

wazusnalndlAes deyadyiusdoudadudeyaimia ilsfuuaduiduadfeududs d

¥ (%
1 v A 14 aa o

sruvasaumanaiaansiglunisiesigi nsnseaeAnvilioudavesanidinuie
A28735 Inverse Distance Weighted (IDW) LUT8ULsUABlUIBA8LAINAUILAAI83TH99)
nnsUIsuisuNan1sAuIudpLasRvlusfeLasnaNsaldlia e nduaslaudugn
ﬁ?jfﬂiumiﬁﬂw’lﬁﬁa 75 Average Seasonal Change Index (ASCI)

Santo et al, (2017) vian13Anwinsidveyanisiausuadrulunseu (TRMM)

v A a g o U d’l Q‘ ¥

WazATUUIHIAAUNNATEIU (SPI) §19SUNNTATINEBUAMNLUTUTIUYBIN UL ALY
wasludsiuiluguin Sao Francisco lnasail Standardized Precipitation Index (SP1) 18u
v 1 1 Aa a H = o 1 Y v g vy a
AvilAu 1z duninsanUsinaduRnsLilieAMmUAYIn Auas JaraldtoyauTunu
unlunldlunuilszneusedeya TRMM 3842 (V7) 91931810 46.75 °04 43.75 ° W wagan
21.00 °04 18.00 ° S (5931 13 x 13 = 169 A39) IA1UALLDEATINUA 0.25 °x 0.25 °FausiLhau
UnIIAY 2541 eSuNAN 2556 FNvianua 16 T Feusasyaiaai 5844 Juiindeyasieiu
lasuAseiioutasseUnudeyauTuiutinus 18 iuIna sy TRMM kagn1snseany
v a & 19 a i o H o
Toyardanulaguszunaldagldinatianisussanamssesnanaulagiviin

qusT Hanzd (2016) AnwndeafiunmsidseuiieuiagmanuduiusseniteUsunasu

a

nsndalalauanaiieuas
quUUIY YoyaveuiA

q

a [y

Herinefuusinamunasaialaanaaiidindumeaiuuluiug
I N1 YoyaruINNN1TAITIAMEAITEN Yoy arulnaalindy

a al

L a acl aa a U v = ~ a A v
AMANUAY LAZITNISNIEDRADANLTIUNTATIEIUANUTUNUS Az SsUEUUS LN UL
217 TRMM fuUSanaeluainannidinelu

aAug1 8onda (2559) laAnwiiiAs1giinisiSeuievuSunauiluseiusening

a o s 8 % P Y -4 Famtll, g A ~
AR UnEuINToyam sy TRMM fudeyatluniaiiuiu Auinamtevesuseine
Ine Tul w.a. 2553 wag 2554 lagldion15n19add 1 @ un Bias, Root Mean Square
Difference (RMSD), Mean Absolute Deviation (MAD), Probability of Detection (POD),

False Alarm Rate (FAR) uag Critical Success Index (CSI) Han15AnwINU71 USuauinelud

v Y = a1 1 dil’ a [ 1 1 aaa a 96’ sg a
nsdInneaRsuilauInnI N unaNuAu duaulng Tudndvsuadinuann dneun
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nfadsarifisnasddunnnirunaiuiu venaindwuhemidfies TRMM 3842 V.7 8
ﬁm’muﬂwiaﬂ,uﬂ'1imaﬁmﬂ%mm{fmummzﬁwumwﬁﬂimmqaﬂu

Wi Aanswedana uazane (2559) lAANwIABTUTEAUANLTULTIVBIATINLAS
LLé’wwé’mqaﬁaﬁwEJﬂuﬁuﬁfjuﬁwazLLﬂﬂ%’a Fredyididunnsgiu Standardized
Precipitation Index (SPI) uagAutauuianasniegniesinegl The Meteorological Drought
index: D) Tngldfoyauszunaniluainanidindadu owisuifisunanisdnutunanis
Anrinnuuiudwonsaniuetnnit nanisfinunudn fuflduiasun nissauane
AnuwiaslusEiuteeiaUuna1slaelAavl Standardized Precipitation Index (SPI) ®¢
5¥7319 -0.45 09 -1.41 Wazsuil The Meteorological Drought Indexagsening -11.75 ia -
26.62 \forFeunan g ianuuindmwansundneansin nudinisusdssduny
JULTBIANLUIILE BT Standardized Precipitation Index (SPI) ffflaanadasiuna

NMTIATIZRAINLAILAINNAAUTUTAeARTE The Meteorological Drought Index
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A9AHUNITIAY

[
v

U

i

Junsfnwvegeunasiviouiisudviiifeudangnieamineausedoya
HENAUIUIEY TRMM 3B42 V.7 aandeganiaiiiuy TRMM luiiuiidnen 9 fanianiamile
nauans laun fivadan iwysysal @asiing alany min wAsaIssA N3RS wazeviesiil lny

ANSANWIULADN 4 Aall Ao AUl Average, Decile Range, Standardize Precipitation Index

v
ad o ¥

(SPI) azGeneralized Monsoon Index (GMI) Lﬁaﬁﬂmmfmgﬂﬁaammzammﬁ%wnma
W 4 gl I avusiseiun1sise Tnefiseazdonudadu 4 dw ddl

3.1 ipseslefldlunisive

3.2 ToyauazivaItoya

3.3 MITIVTINTBLA

3.4 MTaszvivoua

3.1 w3esdiofildlunsise
1) paialneTdIuuARa Intel(R) Core(TM) i5-4210U CPU @ 2.40GHz RAM 4.00 GB
2) Waknsuneensaunagia1ans
3) Microsoft Excel 2016
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3.2 Yoyauazunasdoya

M19199 3.1 Yayauazuvasdayanliluniside

a1 doya/gunsal  Usmaw uviasna/daya

1 nARAUY TRMM3BA2  Raster — http://trmm.gsfc.nasa.gov/3ba2.htmINASA
V.7 0.25° X 0.25°

2 G ITALY, Vector nIuRteNInen
3 YBUIUAYEIYATIMIA  Vector YDUIANITUNATEY
4 deyaniganudvuas Excel nsuUesiulazuIsimansasie

3.3 1133IUINTaYA

(Y] [

Yo Y Yo < v Pt = Y 1w a ~ ¥
Felavinisnuusudeyanldlunisfine laud Jeyandegailinuiny way

Y

E>IY

a (% & o

NaAnAMIINEY TRMM 3B42 V.7 Wnedltumnau sanaluil
3.3.1 NNREa1UIRUINY

a

1) sausdeyaiiinaniinuiduvesnsuendowinelunui 9 Janin

9

[

mewilonauans Insusiaganiiainduszussnaudae Seuin Foanni swaaond uasfidn
magiimans dadiuiuvazie (Latitude) wazass3gn (Longitude)

2) @onamitiaiiduiiagldlunisdne Tneidenlinseunguitudidnu
Mntuinsuuuutoyafidnaniidinwy Insthagfgauazansigaiioglusuuuvose dum
Waua wlaslviegluguuuussmmeiiey

3) dhdhglusunsuneansaumeagiicnans tilethsiuvisvesfiinaniiifn
iiulUafndeyaUsinnumuse Tunnaninisidann TRMM 3842 V.7 Inglul File > Add
Data > Add XY Data > [denldfifnanimincu a1nifu X Field: idenlifuanidgn uas
Y Field: \donlifuasfigauaznin Edit iiousuudszuuidn Selusidedasldssuuidn

LL‘U‘UQﬁmam% (Geographic Coordinate Systems) Inaidon Geographic Coordinate Systems

> World > WGS 1984 > OK sianw 3.1 dstoyaiinidasidusuuyauaziviiedussen
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Add XY Data X

A table containing X and Y coordinate data can be added to the
map as a layer

Choose a table from the map or browse for another table:

[ Sheetts )=
Specify the fields for the X, Y and 2 coordinates:

X Field: Long w
¥ Field: Lat -
Z Field: <None> v

Coordinate System of Input Coordinates
Description:

Geographic Coordinate System:
MName: GCS_WGS_1984

[ show Detats

[Jwarn me if the resulting layer will have restricted functionality

About adding XY data 0K Cancel

2 3.1 msdndaniiasaiiidadiruaaniintiuglusunsuaisaumnaniangns

3.3.2 WARAITHY TRMM 3842 V.7

1) aaiflvannandasiiidy TRMM 3842 V.7 fifleuasidenauin 0.25° x
0.25° 4aldurarndeyaniatiion TRMM n1stiuled@ildusnisliae
https:// mirador. gsfc. nasa. gov/ ¥®3% National Aeronautics and Space Administration
(NASA)

2) §3¥udesnsanadinansdnfasiinly lngiinsimunuaiuiiby
MAmionouaarafidesn1siInm 3.2 lurasszesinal & U fe W.A.2552 (2009), ..
2553 (2010), W.A.2557 (2014) Wway W.A.2559 (2016) 6’850Nﬁmﬁmsﬁﬁ;muﬁﬂuivda‘umaqa

NetCDF (Network Common Data Form) %138 .nc4
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GIOVAN”I The Bridge Between Data and Science v 4.31

Select Plot

® Maps: Time Averaged Map * « Comparisons:  Select.. = Vertical:  Sefect... = Time Series:  Select.. = Miscellaneous:  Select.. =

Sorry. The current number of time steps (517 daily) exceeds the maximum (4) we can process for Time Averaged Map. Try reducing your date range. (If you log
time steps will be removed.)

Select Date Range (UTC) Select Region (Bounding Box or Shape)

YYYY-MM-DD HH:mm Format: West, South, East, North
2008 -12 -31 82 fo 2010 -05 -31 97.0313,13.2715,103.4033,19.3799 1 % x
Valid Range: 1998-01-01 to 2019-07-31

Select Variables

Model (1242)

Observation (565)
¥ Disciplines
Aerosols (193)
Atmospheric Chemistry (77)
Atmospheric Dynamics (424)
Cryesphere (13) )
Hydrolagy (1003) & ]
Ocean Biclogy (59) il *y
Oceanography (62 i

14°40'N, 102°20'F

/l-

J \
B0"00'E @ 95°00'E 1/100700°E “S405900E " 110°00°E

Responsible NASA Official: Angela Li
Web Gurator: M. Hegde

NAsSA

2N 3.2 MsarilvanuEas iy TRMM 3841 V.7

3) wlasnandmeiruaningwinana .ncd liilu tif seluswnsumig

arsaumaniiaans Lagly Model Builder #4013 3.3 ey Lann13vinau & Iterate Files

U v
< o o o ]

JHumdnudn dauasesile Multi-dimention > Make NetCDF Raster Layer t8un1sid
wnSasiauidulnduisana .nca dsnw 3.4 uaziedosile Data Management Tools >
Raster > Raster Dataset > Copy Raster Lﬁuﬂﬂiﬁﬂaaﬂ%;ﬂamﬁﬁﬁ?LG&TWLW@LLUadLﬁummqa
tif
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sumdaiinandinusunldlunsfineine 4 U melusunsunsansaunagienans ngld
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AauATuINIURT U vusaziRs uANs s gl Innunldlunsinw

#, Extract Multi Values to Paints — O X
Input point features
| sathane | B
Input rasters
I =]
Raster Output field name +
& A dip_0g, tif dip_08
x
£ >
[ Bilinear interpolation of values at point locations (optional)

Cancel Environments. .. Show Help ==

2N 3.5 msaé’w%’agaﬂ‘%mmﬁmumnwﬁmﬁm%mmmﬁau TRMM 3B42 V.7
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3.3.3 9ayaT8UNBUA
lumsfnuillasiuswdeyanenuioudinnsudesiunazussiniansisa

Folul woA. 2552, WA, 2553, W.d. 2557 wazd) w.a. 2259 saviavan 4 U e lidusayialy

¥
v ad v 1%

nsnaaeuLUSUgUAUgNARIYRINIsAnwAvidfeuas Tagluaed w.a. 2552, w.a 2553
way w.A. 2557 fnsseaudoudadussiudoria s1ne fua warveniwiesreziafiiin
Foudauaz fuiiAuanfouds el we. 2559 fnsssnufoudadussduiomiagtduuas
Uaﬂﬁ«i'ﬁzazLamsuaqmiLﬁmﬁaLLﬁML@ﬁﬂJﬁﬁA@@ﬁ&LLé’q

INFUSBRdTlasIuT WU luudazd n1s1euSud s seeuIn
WEvidelaiuds dausufieriauasiunds wuiluuaditnssenusasiiuivszaudouds Tay
it feudesilesunstuiinglefuiidun finnsnaueauiidussernamioden
LinnauliAnnsuauraut auiliAsnansenUieUsEwU Msynwasnssy Sy

NSANYHABRAITITIUA HeuauigulnausinAka s AuuaImnIwIUNYATNTTUMEY

3.4 M3AAINTRYA

3.4.1 MSAUIUNBULAIABAYTA19
suiid Auudsiinanoviin Tunseneiidenldnisduiadouds ¢ fudl fie suil Average, fil
Decile Range, §i91l Standardize Precipitation Index (SPI) e g%l Generalized Monsoon
Index (GM)) lumsinseisnanldldusinanihuiildannmsatnannandasiinu TRMM
3842 V.7 \Jushuuslumsiumniaissiisonds lnefnnselusunsy Microsoft Excel &9
A 3.6 uenntdalfiuSeudeuludmusengniadmiudaiinnag Snde ioTasgid

dulutisfouladugisiafinngalunistdeudale

ARTARE |ﬂ§m1mﬁ1h‘u order(i) |data [sample quantigdZ-percenties A Ts0 |1Emmﬁ1v.‘u \ovder(l) \data |samp\e guantiles \Z—percenmes
1 8.91 1 0| 0.041666667 -1.731664396| 1 12.69 1 0 0.041666667 -1.731664396
2 [1} 2 8.91 0.125 -1.15034938 2 0 2 12,68 0.125 -1.15034938
3 34.000107 3| 19.82093( 0.208333333 -0.812217801 3 40.1105 3 13.86  0.208333333 -0.812217801
4 57.501518] 4|34.00011) 0.291666667 -0.548522283 4 61.491772 4 17.72054 0.291666667 -0.548522283
5 82423035 5| 45.2034 0.375 -0.318638364 5 70.84404 5 401105 0.375 -0.318639364
6  82.300491 6| 57.50152( 0.458333333 -0.104633456| 6 79.637001 6 61.49177 0.458333333 -0.104633456
7 144.068893 7| 58.29867| 0.541666667 0.104633456| 7 124.827202 7 70.84404 0.541666667 0.104633456
8 221.558685 8| 8230049 0.625 0.318630364 8 178.328004 8 79.637 0.625 0.318639364
9 148.213074 9| 8242304 0.708333333 0.548522283 9  161.366226 9 94.40111 0.708333333 0.548522283
10  5B.298668| 10| 144.0689( 0.791666667 0.812217801 10 94.401108 10 124.8272 0.791666667 0.812217801
11 19.82093 11| 148.2131 0.875 1.15034938 11 17.720539 11 161.3662 0.875 1.15034938
12 45.2034 12| 221.5587| 0.958333333 1.731664396| 12 13.86 12 178.3281 0.958333333 1.731664396
05 o
=(-0.5)/12 =NORMSINV,sample guanties =(-0.5)/12 =NORMSINY, sample quantiles
ol [snanheuJorder(i) [data [sample quantil{Z-percenties wisas Usnauhwly  [order() [data sample guantiles |7-percentiles

1 14.94 1 0 0.041666667 -1.731664396| 1 1341 1 1] 0.041666667 -1.731664396
2 0 2 14.94 0.125 -1.15034938 2 0 2 7.47 0.125 -1.15034938
3 32.018639 3 27.37 0.208333333 -0.812217801 3 41.828678 3 12.25689 0.208333333 -0.812217801
4 66.554657 4 28.0367 0.291666667 -0.548522283 4 61.335327 4 13.41 0.291666667 -0.548522283
3 67.07251 5 32.01864 0.375 -0.318639364 5 107.698067 3 41.82868 0.375 -0.318639364
6 130.391373 6 66.55466 0.458333333 -0.104633456| 6 260.424225 6 61.33533 0.458333333 -0.104633456
7 178.318008 7 67.07251 0.541666667 0.104633456 7 359.466675 7 107.6981 0.541666667 0.104633456
8 201.640152 8 123.6945 0.625 0.318639364 8 314.133789 8 124.0091 0.625 0.318639364
9 232.187958 9 130.3914 0.708333333 0.548522283 9 264.182251 9 260.4242 0.708333333 0.548522283
10 123.694511 10 178.318 0.791666667 0.812217801 10 124.009087 10 264.1823 0.791666667 0.812217801
11 27.369999 11 201.6402 0.875 1.15034938| 11 12.256889 11 314.1338 0.875 1.15034938
12 28.036701 12 232.188 0.958333333 1.731664396) 12 K 12 359.4667 0.858333333 1.731664396
1266.13374 o 1327.574337 0

AN 3.6 AH29819N15AUIUATTNBKAS LY TUSINTY Microsoft Excel
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3.4.2 A15ATITINITNTLA1ENTUTLUIUANTINUNVDINBUNULLA
Tunseuussilnundsmenuidng 4 aull azlaasuiy Nouasvaiunazing

'
aad

a0l dududeyaduandeadnfieanunlusuuvudoyaiBeussens udlunisinuifeanis
Wisuiiteudeyaideiiud fufufshssuuasaunagiimansiduntslunmaoudeyaada
ToglusuuuuiBeiiuil lun13@nwnilléle38 Inverse Distance Weighted (IDW) lun1siinse
Feiiuil Tneldiadosile Spatial Analyst Tools >Interpolation >IDW #9nw 3.7 9z19iufiens
nszeLdansUsvanariufivesfeilfouds fenm 3 8 uagtnnTeuiisuaugniestiu

UINUN YA

#, IDW — O x
Input point features s
|sathane_5pi ﬂ E;-

Z value field

| 52.m v|
Qutput raster

| D:\Research Data'data\Data'jdwidw_s_55_mm | [,'—_'3;-

Qutput cell size (optional)
| 00787142544 | I

Power {optional)

Search radius (optional)

Variable ~

Search Radius Settings

MNumber of points:
Maximum distance: I:l

Input barrier polyline features (optional)

-
| e
Cancel Environments... << Hide Help

7w 3.7 segenistididayamsyaiiingandiussunaadavui IDW
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350
Y =0.9262x + 15.244
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E 20 R = 1.8138
~N 200 R*=10.9069
q
P
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=
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o
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Station_rain (mm.)

NN 4.2 Anudunusszrndnetaya TRMM3B42 Audsuiadiruainanit

pA
U/ =

4.3 n1sUssiunvingwaanutl

= v A ag v = & Ao = .
nan1sAnw1aanasdnldlunisAnerninundn v (Average, Decile Range,
Standardize Precipitation Index (SPI), Generalized Monsoon Index (GMI)) Taan1susziiu
NNITATIERAIUFLNUSFe Vo andn sl TRMM 3B42 tivanadaunviianuuiauasly
O aAu a v ° ] P | a a0 = L8 v =
ndswll Tegldnisamuassavaniilundazinouresanninug Tun1sdnwilld 12 aond
LAZUINANAIUAIULARLAYLN L USIUMBUNUS 189 1UTBINSUTBIN ULATUTIINAISISUN Y
(Un.) 1iiBLUSgUMNATENABAAADINUIIEITUN B LASKAZLALNLAUAUNISTINNUWAY LABLAAY
U AW v A o ° | U g Y A | ) Y &
sutfukasnunluauasarsullinanaIawane1eny faseludl
4.3.1 sl Average FudunisauinlagldiSnisiadenisadamans (Arithmetic-
mean Method) 1ayAadsUsuIMuINL 910NISAIUIMATUATLAT kaUNULUS U
) % Y v oA Y v & a = 14 |
AUANNADAAABIT I UNILAIN LB U UTDLARDTILULTINUR WU
1) doyauIunauninlusiet Tud w.e. 2552, 2553, 2557 waz2559 B4laan
N15U7ANUSEIN NN US89 TLN A WIULAEEILUS I UTB UAINUADA AR S LLLTINUASINLAR
Aoudaiusnenuseuwdsnldadudeianse Souaz 16.6%, 8.3%, 33.3% way 16.6% AUASU

1AYRALNINUA 18.7% F9NN 4.3
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Assessment of drought indices using TRMM satellite rain product

in the Lower North
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ArdAgY - Aolas AYtfuwLad , Tropical Rainfall Measuring Mission (TRMM), TRMM 3B42
V.7
Abstract

Drought severely affects the Thai people every year. The application of drought
indicators can reduce severe impacts. However, = the accuracy assessment of the
drought index is the first step to be studied before turn it into practical task. Therefore,
the objective of this research is to study the accuracy of drought indices in the lower
northern region of Thailand by using satellite rain estimates product, tropical rainfall
measurement or TRMM 3B42 Version7. By subjectively selecting four commonly used
drought indices which are average, Decile range, Standardize Precipitation Index (SPI)

and Generalized Monsoon Index (GMI). TRMM product was extracted corresponding to
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rain gauge position of Thai Meteorological Department (TMD). Then, Inverse Distance
Weighted (IDW) interpolation method was applied to obtain spatial data of those
indices. The results show that SPI is more accurate than other indices when compare

with drought report from department of disaster prevention and mitigation.
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2) weUsziuiuuiudslunmamionsuans IngldveyauSunanicuanguteya
ALY TRMM

A e
NUNANWI
dt:gllu [ v

nsfnwanugniesvesdeidnsoudluiiuiimamiionoudts Uszneulugae 9
Jandn lown damdaiivadan iysysel @nsang gluvie n1n UATAITTA MUNLNYT TS wag
Y511l ST avun 83,792.034 miv1sdlalnsveyssanm 52,370,021.25 15 dnwaznil
Uszina Sameuvuvesivuiiniaiviionoudaidnuargiivssmaduiisuguuidiuasfis
anyin (rolling plains) WA Aufiluuiinmuneunatmasdminfivalan gusing dlafie uas
pn fufireudrsosmaiduiisugy fuhbaeddyvad il uhihds uiih s wides
wazutiiitu Selwausnussaufudunsidndmsser 1Hun uasassd funanes Adas
uaygiiusil (drinumsgnsmaninguiminanamionoudn, 2556)4] fnansluniwd 1
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gunIalIsn1sfinen
1. msinsgudaya

(%
v v

M93densall 1un193deidaU3an (Quantitative Research) Fsldamugniosasivildindy
u&ilaeindondayadieluil

1.1 unastoyauazinzasiionllunnsise
M9 1 dayauazintesilalilunmafiusausautaya

o w o % ¢ Poa %
a10UY Yaya/gunanl Uszban WUAINU/Voya

1 NaRAUI TRMM3B42 Raster http://trmm.gsfc.nasa.gov/3b42.htm(N

V.7 0.25° x 0.25° ASA
2 amilthey Vector NIURANLINEN
3 VBULUAYDIYAIININ Vector YBULIANITUNATDS
4 HRRRENVRIIR Excel nsudesiulagussimansn sy
5 ArcGIS software I‘LJiLLﬂima’ﬁauLVIﬂVI’NQﬁﬁ’lam%
6 Excel software . 1Usunsu Microsoft office Version 2016
7 pauRnaslinyA software Lenovo K4450,Intel CORE i5

1.2 nMsniusiusandaya
1.2.1 Joyanimegrea wAgu TRMM A13ulvannma1eana1Lies TRMM
HuTRMM 3842V, 7 adudeyauimnashuuuunetu fiflanuaziBonvuin 0.25° 0.25°
Tumsidoadstldnmeaieuest w2552, 2553, 2557, 2559
1.2.2 foyafifaaandiaidy srusudeyaiinanidfadiduainnsy

[% (%
o

gnfiewinen Tueiiud 9 Smiamemilonoudrs Tnsudazani¥miduiuazlsenoude
swiaannil Jeannil azfign assfgauaztedmin
1.2.3 dudfoussdondutinoudn 4 38 loua
(1) fivtl Average
\Hunasl¥38nrsiadonisadnmans (Arithmetic-mean Method) vAniafeU3u sy
(Chow, 1964)[5]
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i
Rk = l:lR I k

R, Aausuahsluselvsesiegania vesuik
R AoUSunaimusneiiou lusioud | 10907 k

i AD PRUSUAUNNRINTUN

J Ao ieuganeniansan

#UN15% 1 N1sATLINTIIARAsUSHNanNuTAFnYn

Z{=1 Rik
n

R, -

v
a °

R, Aousunauisluselvioneggnia wade lugi n U (n=30 ¥)

2 USuANANNTaN

o))y

9 Ugaveniiansan

o))y

J

A o ah Y

4N 2 A15AUAURIAIRASUSNMUNE N30T

(2) @il Decile Range 138 Rainfall Decile
BsuvsogauSmanimuseniu 10 919919 i Y338z 10% (Decile) voinasi
YB9N1TUANULIAINLDAZEL (Cumulated Frequency Distribution) (Gibbs and Maher, 1967)
[6]

Ajjn— Hijn
9Ngn3 Zijn = ——=
’ Oij,n
[ Y @ —_
Jaguaunslondu Zij,n = Uijn t+ O'ij,nZij,n

Togil Xijn Ao U%mmﬁnﬂuswﬂw%aswqama lugan ¥

Uijn Ao ﬂ"1aﬁaﬂ%mmﬁmuswﬂﬁaiwqama Tor2a n U

Oijn f® a'autfjmLuummgmﬁuaqﬂ%mmﬁﬁmumaﬂﬁaswqgma luge n ¥
Zijn 8 Quantile ¥83 Normal Distribution °uaqU%mmfmuﬁw%%aﬁaqqma
Tugan U

N N

i A WHRUSUANANINTAN

o))

j A9 weugaveniasan

= vV
MuUvaNa

b
Do

n ?

#un159 3 N15ATUIAL Decile Range
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(3) Al Standardize Precipitation Index (SPI)
ST Wy Lﬂﬂﬁ%ﬁﬁﬁ@ﬂﬁmﬁlaﬁ’muﬂLLaleﬂ’]Qﬂﬂ’l’JzLLﬁﬂLL%&I@EJU%@J’]QJ&’WM
Tnensaziioufsnnnuuiaudainmsuaduiiduiadefidmaliiinsowdduusasiiaiiios
lUanuni(rfRdss ioulde ,2561) [7]

Ki- X
SRL=
(/)

X Aowan siavsunaudufywnaundntl i o oy j (Hadung)
ij
X AsvdsunauieuedesigieursUnanenveslnanwivesanill (Naawms)

im

O AedudeauuiInggIu

A1N157 4 MIAUIUUNWNIINATIEATLAUAIIUTURTIVDIABUAS

(@) @21l Generalized Monsoon Index (GMI)

A A

L uAPBEAIULIAILA IR UNITIN YA T TLAAIDINANTNUTLARTULANYANS 1S LA UTH

<

= A

FALANNANIDINAITVIALAAUAINTU LANI TN UT IR UARALADUT g UIEUDLsIaY

q

fugI8u
GMI = 0.125 P6 + 0.125 P7 + 0.5 P8 + 0.25 P9
Audouliguisn GMI6 = 0.125 P6
Audtounsngian GMI7 = 0.125 P7

v

Aufioudaiiau GMIS = 0.5 P8
Audeufiugney GMI9 = 0.25 P9
GMIpct = (r x 100)/ (n + 1)
GMIpct : percentile rank 83 GMI
r aduiivesAdeyaiu GMI vastiu 9
n:  nlvesloyavedudazanil

r<n Wag GMl <100

aun1si 5 Avllusgamaly
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2. MATIzidaya
2.1 uaswiinfnuisluaniifign TRMM 3B42 V.7
waslwduvanasinnisenilnasfieldlunisadnandeu 1410 sunsu neiadesile
Multidimension Tools tioudaslnidnimainuiuana .nc Widuwuana tif
2.2 thidshumisisnaniTachelu
2.3 Sunnfoudsiesuivadfoudeiag f

[ '
=] )

2.4 WIBULBUAINNABIYDIRBHABREUTINUNTUT I8 UTBULAS Vo9nTY
Uasniularussimasnsudy nsensasumalng (Un)

2.5 A5 EAsNsT YRR U SUua LU
Tunsfusnivived foud et udnfu axldmuiivadsoudsvecaaniSnieu waz
5189UABRAY VoINTUTDIULALUTIIMIENTITUNY NSENTIUMIA LN s?falﬂu%’a;ﬂaaﬁaaaﬂm
Tuigsussene 1umﬁ€fs§¢7mmaﬂ%‘suLﬁauﬁagammﬁm%aﬁuﬁ Taaldlusunsunig
ansaumananiaans vielusunsuArcals Tunisuanamaludsiiun Tnaldiedasdie Inverse
Distance Weighted (IDW) Lﬂﬁlsummgaaaa‘lﬁaQTuEULLUUL%Qﬁuﬁ

NAN1SANE
1.n15.030ULe UANLdenAde eI s A IR fud s uusne Tuseuse
TGN
1.1 35 Average
1.1.1%’ay”aﬂ%m1mﬁéwslu3wﬂ 100 w./.2552, 2553, 2557 waw2559
firnuaonndoslul@eiud fussanudowde 16.6%, 8.3%, 33.3% Wy 16.6% ANUASU Lag

LAYTINUA18.7% FINING 2

- ub:

‘ Biuds

A 2 wuiiviunanhiuildanmsduindud Average doyanelusudisuiuanugenndosnenusiouds
(AYU2552, (B)U2553, (O)U2557 uaz(D)U2559
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1.1.29ayaUSunaniiusieggnianusidoun.s 1.y, Tl w.e.2552,
2553,2557 Lar2559 fimnuaennaaslulBeiudl fusieeusends 50%, 58.3%, 33.3% uay

75% MUANU LRELRasNIiun 54.15% A9n1NN 3

Y
« W uay 0 W ude (ol s

7 hiuda - g ~ T 1 "hinda

1 Tsinda

bt 5

A 3 unuiivSnaninduiilaainnsaiuaasei Average dayangganiaTeuiiguiuanuganndosuisud
(A) U2552, (B) U2553, (C)U2557 wae (D)U2559

1.2 75 Decile Range %3® Rainfall Decile
1.2.1%yausunanimus el Tl w.a.2552, 2553, 2557 uav2559
TANUFAAA BT lULTINUT NUSIBIUNBLAT 33.3%, 8.3%, 58% WAy 33.3% AuanUlae

LRAYTINUR 33.3% AININTA 4

-l
Binda

AW 4 wnuiivTinaieluiildanmaduauded Decite Range FayameTiusuifisuiuaudenadesnenufouds
(A)U2552, (B)U2553, (C)U2557 uaz(D)U2559
1.2.2 Yeyausunahluneggnadawsaeun.g.-tay. Twln.e.2552,
2553, 2557 Waz2559 {Auaennaad bl i unAUTayas1891uduuas 25%, 8.3%, 58.3%,
WAy 33.3% UEIRU INELRABTISNUA 31.24% AN SATMNT 5 wNunUIunaiuila

B C D

2MNN13AMUINAYT Decile Range dayaseganiaileuliisuiuaiusanndassenuiouds (A) U2552, (B) U2553,
(C)U2557 waz (D)U2559
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1.3 35 Standardize Precipitation Index (SPI)
1.3.17yauTinadusel Tulluln.m.2552, 2553, 2557 uay2559

TANUADARADILULTINUN NUTI18IIUNTLAY 58.3%, 33.3%, 33.3%, way 41.6% Lagiady

Favun 41.63% e il 6

-l R s
Thiuba

A

Al 6 wauiiUSunanhrudldannnseuiyil Sl dayaselilssuiisuiunnusanadosnenuisuds (A)U2552
(B)U2553, (C)U2557 waz(D)U2559

1.3.2 oyausunaiiausigganIanausiioun .1y, Tuln.a.2552, 2553
2557 1a¥2559 HANNADAAADILUTINUT AUIIBIUABLAS 83.3%, 75%, 33.3%, Uay 66.6%

ANUAINU TALRANUA 64.55% AINTNA 7

7
[ £ whnlwinme B 4 S -
A 3 y SEaR™ Y k.
R Sab o A n-\q
3 pe P &
> 3 - 3 ( -ﬁ&- s
K L "‘Q""[ § ————
Ay SR
S ) -
T

At 7 wuiiviananirduitldanmsannseil spl deyaneagnmansieuiiisuiuanusenndessenuisuds
(AU2552, (B)U2553, (C)U2557 uaz(D)U2559

1.4 35 Generalized Monsoon Index (GMI)
1.4.199yaUSua Il uTIgaN1atInAUTQUIB DY LouLYIEY

Tulut
W.¢.2552, 2553 2557 Lay25595mnaenndadlindsiud fuseeufonas 0%, 0%, 83.3%

way 0% lAgLdsvanun 20.83% H9N1NT 8

ks

At 8 wuiiviinanirduitldanmsdunndeil oM dfeyanengniasuiiisuiuanusenadasneauieude
(A)U2552, (B)U2553, (C)U2557 uaz(D)U2559
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agUnanIsAnEN

Mnnsvaspufoudsiedrivendfoudei 4 fulluddnedoyauimaiicused
LAYTIBARNIAAIIY WU 929 4 Fivinsuszifiufouda Aot w.a.2552, 2553, 2557 LAy
2559 1 FuiltSouds ﬁiﬁi’fﬁﬁaaﬂaﬂ%mmﬁfflNuﬁaﬁ’ﬂié’mﬂwémﬁmsﬁmmmﬁEm TRMM 3B42
V.7 dhndwamadildnuin dail Average Iinagneeslugliau w.e.-13.y. avil Decile
Rage Winagneaasluyiesied duil Standardize Precipitation Index (SPI) Tinagndaasluaig
WU W.8.-11L. futiGeneralized Monsoon Index (GMI) lvinagnsiadludiasiow 1.6.-n.g.
definnsanesisudmiudenndesiusisnuiouds sl Average Sanueaonndos 1 T s
s1eluarsggania Asd2553 83.3%uazl2559 75% n1ua iy Avil Decile Rage AA114
aonnang 1 U ﬁaawﬂuamwsqama AU 2557 58.3% wazU2557 58.3% A1ua1ay Al
Standardize Precipitation Index (SPI) fia1ug@ennasy 2 U AaU2552 58.3% wazU2555
41.6% Yo1318T Uazl2552 83.3% Warl2553 75% ¥8951990n1a #Y¥ll Generalized
Monsoon Index (GMI) flenuaenndesd 1 T 5189gn1a Aetl2557 83.3% wlefiarsanudadil
Standardize Precipitation Index (SPI) lvinagndesuazaennnedfiusIgnuiaudauinningvil
31 afustail Standardize Precipitation Index (SPI) fiaaugndassnnitgalunisnnaesuste
WA

AnAnsIuUIENIA

mua:ﬁ%{fasuaﬁuauqm National Aeronautics and Space Administration (NASA) o
mmmgLf’mzﬁu‘%mﬁauﬂawﬁmﬁmﬁfmmﬁﬂ%’aaﬂamuﬁam TRMM 6nunn Goddard Earth
Sciences Data and Information Services Center (GES DISC) Wa wmauwaz@m%’auﬂaam
nsugAfienivet Snvnsadosiunarussmassnedenioyeszideyaililunsiide

LANE15891489
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